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How to Use This Guide 
 

This guide is written for researchers and laboratory staff responsible for installing and maintaining 

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block. 

 

General Requirements for Installation 

 

This guide assumes that you: 

 Are familiar with Microsoft
®
 Windows

®
 7 operating system. 

 Have basic techniques for handling DNA and RNA samples for PCR. 

 Have basic skills for data storage, copying and pasting data into hard drives. 

 Have an experience in setting up a network. (Using any data generated by Exicycler™ 96 Fast requires 

setting up a network.) 

 

Word Conventions 

 

 Bold signifies user action such as typing a text or clicking a button. For example: 

Type Test and click OK to move to the next step. 

 Italic represents important words or sentences and is also used for emphasis. For example: 

After analysis, you must save data using Save As. 
 A right arrow in bold (>) separates consecutive commands you selected from a main menu or 

shortcut menu. For example:  

File> Config> Scan 

 

How to Obtain More Information 

 

For more information about Exicycler™ 96 Fast, please visit us online at www.bioneer.com. 

 

How to Reach Customer Support 

 

To obtain prompt customer support, please call us at +82-42-930-8777. You can also obtain technical 

support through www.bioneer.com (Email: exicycler-support@bioneer.com). 

 

Product Use Limitations 

 

 Exicycler™ system is designed and sold for in vitro diagnostic (IVD) applications in combination with 

the diagnostic kits manufactured by Bioneer and labeled for diagnostic purposes. ExicyclerTM
 system 

can also be used for life science research and other laboratory purposes.  

 Gradient function of Exicycler™ 96 Fast is not available in US, EU, Japan and Germany.  

 Use of Exicycler™ 96 is covered by U.S. patents Nos. 8,139,210, 8,427,643, and their foreign 

counterparts or pending patents. The purchase of these products includes a limited, non-transferable 

immunity from suit under the forgoing patents for using only this amount of product solely for the 

purchaser’s own internal research. No other patent rights to use this product for any other purpose or 

for commercial purpose, including without limitation reporting the results of purchaser’s activities for a 

fee or other commercial consideration, are conveyed expressly, by implication, or by estoppels. 

Further information on purchasing licenses may be obtained by contacting Bioneer at 

licensing@bioneer.com. 

http://www.bioneer.com/
http://www.bioneer.com/
mailto:exicycler-support@bioneer.com
file:///C:/Users/B110036/Documents/매뉴얼%20파일/ExicyclerV4_작성%20중/A-2060-1(Normal%20model)/licensing@bioneer.com
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Safety Labels Description on Exicycler™ 96 Fast 

 

English Hot surface. 

Note that you can hot surface temperature. 

Francais Surface chaude 

Faites attention à la surface chaude. 
  

English Do not work long hours at low temperature to Bath. 

We had a condensate can cause equipment malfunctions. 

Francais Ne pas utiliser le bain à basses températures pendant plusieurs heures. 

Risque de condensation pouvant entrainer des fonctionnements défectueux de 

l’équipement. 
  

English Door Attention Behavior. 

Open or close attention to when you crash and insertion. 

Francais Manipulation de la porte. 

Risque de blessures corporelles (pincement/écrasement) lors de. 

l’ouverture/fermeture de la porte. 

English CRUSH HAZARD  

Stay clear of this area during Door operation. Injury can result if you shut your 

fingers in the door.  

Francais Risque d’écrasement  

Ne pas rester proche de la porte durant son fonctionnement. Risque d’écrasement 

de doigts en cas de contact avec la porte. 
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Symbols on Exicycler™ 96 Fast 

 
Safety Symbols on Exicycler™ 96 Fast 

 

The following table describes the safety symbols that may be displayed on Exicycler™ 96 Fast. Each symbol 

may appear by itself or with text that explains the relevant hazard. 

 

 

Hot surface. 

Note that you can hot surface temperature. 

 

Do not work long hours at low temperature to Bath. 

We had a condensate can cause equipment malfunctions. 

 

Door Attention Behavior. 

Open or close attention to when you crash and insertion. 

 

CRUSH HAZARD  

Stay clear of this area during Door operation.  

Injury can result if you shut your fingers in the door. 

 

Electrical Symbols on Exicycler™ 96 Fast 

 

The following table describes the electrical symbols that may be displayed on Exicycler™ 96 Fast. 

 

 
Indicates On position of the main power switch. 

 
Indicates Off position of the main power switch. 

 

Indicates a standby switch by which the instrument is switched on to the 

Standby condition. 

 

Indicates a protective grounding terminal in the instruments that must be 

connected to earth ground. 

 Indicates a terminal that can receive or supply alternating current or voltage. 

 
Indicates a terminal that can receive or supply alternating or direct current or 

voltage. 

 

Environmental Symbols on the Exicycler™ 96 Fast 

 

The following symbol (WEEE) applies to Exicycler™ 96 Fast placed on the European market. 

 

 

Do not dispose of Exicycler™ 96 Fast as unsorted municipal waste.  

Follow local municipal waste ordinances for proper disposal provisions to 

reduce environmental impact of waste from electrical and electronic 

instrument. 

 

European Union customers: 

Call your local European office for Bioneer instruments pick-up and 

recycling.  
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Safety Warnings and Cautions 
 

Safety instructions in this guide book are to cover possible dangerous conditions and situations that may 

occur. It is your responsibility to read this guide thoroughly when installing, maintaining, or operating 

Exicycler™ 96 Fast. The following safety alerts will be used in this section: 

 

 Hazards or dangerous actions that may result in severe injury. 

 Hazards or dangerous actions that may result in minor injury or damage. 

 Hazards or dangerous actions that may cause a burn. 

 Hazards or dangerous actions that may result in electric shock. 

 

Location Consideration and Installation 
 

General Instrument Safety 

 

    
1) Check power voltage rating before connecting to the instrument and an electrical outlet. Exicycler™ 

96 Fast is configured for 100-240VAC (±10%). Using AVR (Automatic Voltage Regulator) or UPS 

(Uninterrupted Power Supply) is recommended. 

2) Exicycler™ 96 Fast must be grounded for protection against electric shock. If not, it may cause 

serious injury and system damage. 

3) Do not place any objects in front of the main door of Exicycler™ 96 Fast that can interfere with door 

operation. 

4) Leave 50 cm space between Exicycler™ 96 Fast and the wall for proper ventilation. 

5) Do not install Exicycler™ 96 Fast in a dusty environment to prevent false operation or technical 

damage. 

6) Keep Exicycler™ 96 Fast away from heat sources. 

7) Exicycler™ 96 Fast must not be installed in an area where it is exposed to water or is humid. It may 

cause electric shock, a fire, or system damage. 

8) Exicycler™ 96 Fast must not be installed in an area where it is exposed to combustible or flammable 

vapor. In case of a gas leak, open windows and let fresh air in. Do not operate any electrical switch 

during a gas leak. It may cause an explosion or fire. 

9) Do not disassemble or repair Exicycler™ 96 Fast yourself. It may cause a fire, electric shock, and 

system damage. A limited warranty does not cover unauthorized alterations or damage due to abuse. 

 

Precautions regarding the electrical environment 

 

   
1) If the power cord is loose, do not use the instrument. Overheated power cord may result in shock or 

fire. 

2) Do not operate multiple instruments out of a single wall outlet. The load may cause the instrument 

to overheat and lead to fire. 

3) When plugging or unplugging the power cord from a wall outlet, make sure your hands are 

completely dry. Wet or moist hands may cause electric shock. 

4) A convenient and safe power cord should be available. The power cord provided by our company 

should be used. 

5) Socket outlets should be at least 1.5 m from a sink or wash basin. 

6) Power cord should not be repaired with insulating tape. Water can still penetrate insulating tape and 
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power cord. 

7) If you use other power cord, it should be adequate for the electrical capacity for Exicycler™ 96 Fast 

(250V, 16A, 0.75mm
2
, VDE). 

8) Plugs should match the socket outlets. 

9) Unplug the power cord from Exicycler™ 96 Fast when not in operation for a long period of time to 

prevent the possibility of fire by overheating. 

10) Exicycler™ 96 Fast is equipped with a 3-conductor AC power cord that, when connected to an 

appropriate AC power outlet, grounds (earths) the instrument. To preserve this protection feature, do 

not operate the instrument from an AC power outlet that has no ground (earth) connection. 

11) Improper fuse or high-voltage supply can damage the instrument wiring system and cause a fire. 

Before turning on the instrument, verify that fuses are properly installed and that the instrument 

voltage matches the power supply in your laboratory. 

12) For continued protection against risk of fire, replace fuse types (250V, F10AL, 2ea) according to 

rating specified for the instrument. 

 

Installation Safety  

 

   
1) Place and install Exicycler™ 96 Fast away from direct sunlight. 

2) It is recommended that you turn off the computer and unplug the power cable before connecting it to 

Exicycler™ 96 Fast. If the computer is turned on while connecting, the communication port connector 

either in the computer or Exicycler™ 96 Fast may get damaged. 

3) Make sure that the USB cable is firmly connected to Exicycler™ 96 Fast and the computer. Unstable 

connection may cause damage to the communication port connector or data transfer errors. 

4) Built-in camera of Exicycler™ 96 Fast is a static-sensitive device. Pay particular attention to any 

cables connected to Exicycler™ 96 Fast to avoid static damage. 

 

Cautions 

 

  
1) Ensure that the power cable is clean and connect it firmly to Exicycler™ 96 Fast. 

2) Operate Exicycler™ 96 Fast in a place where the temperature is always between 15℃ and 30℃. Poor 

performance is influenced by extreme temperature. High temperature can cause mis-operation and 

poor performance. 

3) Operate the system in a place where humidity is always between 20 % and 80% with no 

condensation. Highly humid environment can cause corrosion of internal components and low 

humidity can lead to errors. 

4) Do not place any objects behind or by the side of Exicycler™ 96 Fast that can interfere with 

ventilation and cause errors. 

5) The internal optical components of Exicycler™ 96 Fast may get damaged when the instrument falls 

or is exposed to excessive physical shock. 

6) Unplug the power cable from Exicycler™ 96 Fast when not in operation for a long period of time to 

prevent the possibility of fire by overheating. 
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Operation and Maintenance 
 

Warnings 

 

   
1) The system can be hazardous when misused. 

2) Keep the 96-well thermal block area clean to prevent damage and to generate accurate 

experimental data. 

3) After any Real-Time PCR runs including ‘Scan’ or ‘Melting’, allow the light source lamp to cool 

down for at least 10 minutes. Continuous operation without a break will reduce the lamp life span 

and cause errors. 

4) Do not place a piece of paper or a plastic cover under Exicycler™ 96 Fast. It could cause a fire. 

5) Do not turn off Exicycler™ 96 Fast right after a Real-Time PCR run is done. Wait until the cooling 

fan has stopped running completely. Cooling fan remains running for about 3 minutes to cool down 

the lamp after each Real-Time PCR run. 

6) Do not cover Exicycler™ 96 Fast with a piece of paper or a plastic cover. This may cause a fire or 

failure of the system. 

7) Set ‘Power Options Properties’ in the Control Panel to ’Turn off monitor’, ‘Turn off hard disks’, 

‘System standby‘, and ‘System hibernates’ to ‘Never’. Otherwise, data transfer between Exicycler™ 

96 Fast and the computer will be interrupted. 

 

IMPORTANT:  

Exicycler™ 96 Fast should be operated in a clean condition. Contaminants, such as dust, can cause 

problems and reduce the life span of Exicycler™ 96 Fast. Please prevent dust from entering into 

Exicycler™ 96 Fast. In order to extend life span of Exicycler™ 96 Fast, thoroughly remove dust 

periodically. 
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Overview 
 

 Exicycler™ 96 Fast Real-Time Quantitative Thermal Block combines a thermal block in a special 96-

well format and an innovative fluorescence detector. The detector monitors fluorescence emitted as an 

indicator for amplified nucleic acid product during each PCR cycle in real time. 
 

Thermal block is built into the lower part of Exicycler™ 96 Fast, which carries out a thermal cycling. 

The detector is located in the upper part of Exicycler™ 96 Fast, which measures the fluorescence 

emitted from samples in the thermal block in real time and transfers data to the computer for analysis. 

Data transferred from the detector is analyzed with Exicycler™ analysis Program. 

 

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block provides a maximum ramping rate of 

5.0℃/sec, and features various functions such as gradient, time increment, temperature increment, and 

ramp rate control for myriad applications. 
 

 Exicycler™ 96 Fast Real-Time Quantitative Thermal Block detector consists of a light source and a 

detector. The light source is an energy source to excite fluorescent dyes. A short arc lamp is bright and 

has a long life span. A white-light source is divided into particular wavelength groups by band path 

filters. The band path filters in Exicycler™ 96 Fast covers within 475 to 690 nm and works as a set 

consisting of an excitation and an emission filter. Five filter sets are provided for various applications. 

Therefore, no additional band path filters is required. Also, Bioneer’s imaging technique based on 

polarization of light enhances detection sensitivity for robust and reliable results. Patented (KR10-

1089045, US8427643) polarizing optical apparatus mitigates the common problem of a reflection light, 

allowing precise quantification and target discrimination. 
 

 The detector, a highly sensitive 2D CCD camera, is highly sensitive and detects multiple fluorescence 

signals from a 96-well plate at once. This simultaneous detection has a great advantage over a 

sequential detection. This innovative detector, invented by Bioneer, reduces well-to-well variation and 

has minimized dye-to-dye interference, therefore providing more accurate results. 
 

Bioneer’s state-of-the-art technologies applied to Exicycler™ 96 Fast generate a uniform light surface 

over the thermal block. This allows detection of multiple fluorescent signals emitted from various dyes 

through the light surface and separate signals within a selective wavelength range of each dye. 
  

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block features an auto loading function for 

automation reducing errors and self-diagnosis for diagnosing systematical conditions of Exicycer™ 96 

Fast for users’ convenience. Exicycler™ 96 Fast software is composed of three main programs. 
 

A set up program for calibration test, diagnosis and confirmation of the instrument’s information. 
 

An operation program for creating a protocol, assigning a probe and plate, saving & displaying data 

while operating Exicycer™ 96 Fast. 
 

Analysis software that comes with Exicycler™ 96 Fast has 4 different tools. The analysis program 

includes Absolute Quantification, Relative Quantification, SNP genotyping, and Existentence / Non-

existentence. It is applicable to Gene expression, Quantification of cell and virus, and SNP genotyping. 

 

 

Intended purpose 
 

This device is used for the qualitative or quantitative analysis of specific DNA/RNA in samples.
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Overview 
 

Exicycler™ 96 Fast Real-time Quantitative Thermal Block is warranted by Bioneer against manufacturing 

defects in materials and workmanship for a limited warranty period of one year. Bioneer will charge for 

repairing products for the following conditions: 

 

 Fault caused by the customer. 

 The product is repaired after expiry of the warranty period. 

 

Before you install Exicycler™ 96 Fast, check shipped materials with the system component listed below:  

 

System Components 
 

Component Lists Check 

ExicyclerTM
 96 Fast 1 □ 

USB 2.0 high speed cable 1 □ 

Power cord
1
 1 □ 

Software 1 CD □ 

User Guide 1 □ 

96 well reaction plate 1 pack □ 

Optical sealing tape 1 pack □ 

Optical tape sealing applicator 1 □ 

 
1 Provided according to country standard 
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Specifications 
 

Physical specifications 

Dimension 
355mm(W) x 540mm(D) x 470mm(H) 

13.98in(W) x 21.26in(D) x 18.50in(H) 

Weight 39 ㎏ (85.99lbs) 

Sample capacity/ size 
Opaque White 96-well Low Profile PCR Plate / 

0.1ml Opaque White 8-Strip Low Profile PCR Tube 

Sample volume 10~50 ㎕ (20 ㎕ recommended) 

Power consumption 100-240VAC, 50/60㎐, Max 800VA 

Operating temperature 15~30℃ (59~86℉) 

Operating humidity 20~80%, no condensation 

Thermo module specifications 

Method of heating / cooling Peltier 

Temperature range 4.0℃ ~ 99.9℃ (39.2~211.82℉) 

Max ramp rate 5.0°C/sec (8.1℉/sec) 

Temperature accuracy  0.3℃ (± 0.54℉) 

Temperature uniformity  0.3℃ (± 0.54℉) 

Lid temperature 90 ~ 120℃ (194~248℉) 

Gradient range 20 ~ 95℃ (68 ~ 203℉) 

Temperature differential range 1 ~ 20℃ (1.8 ~ 36℉) 

Temperature increment range 0.1~2.0℃ (0.18~3.6℉) 

Time increment range 1 sec ~ 60 sec 

Ramp rate control range 1 ~ 100% 

Computer specifications  

Operating system Window7 (32-bit OS only) 

Processor speed Intel Dual Core E2160 (1.8GHz) or higher 

Memory 1GB or higher 

Communication port USB 2.0 high speed 

Screen resolution 1280 x 1024 or higher 

Optical Part 

Light source Short arc lamp(120W)
*
 

Sensor 16 bit 2D CCD 

Excitation Filter / Emission Filter
**

 5 Set 

 

* Continuously turning on and off the lamp reduces the lamp life span. 
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* The lamp generates heat when it starts. Make sure that you turn off Exicycler™ 96 Fast when cooling fan stops 

running. It usually takes about 3 minutes for cooling fan to stop.  

**Please refer to a chart below for more information about filter sets. 

 

※The specifications of this product may change without notification for performance enhancement. 

 

† Filter sets 

Position Excitation (㎚) Emission (㎚) Set Fluorescent dye 

1 Blank Blank 1 - 

2 475 530 1 FAM, SYBR Green I 

3 520 560 1 JOE, TET 

4 550 590 1 TAMRA, CY3 

5 570 630 1 Texas Red, ROX, Red610 

6 630 690 1 CY5, Red670 

 

 
Chemical hazard: Exposure to following florescent dyes may cause eye and skin and respiratory tract 

irritation. Read the MSDS before use and follow the instructions if swallowed or inhaled. Wear 

appropriate protective eyewear, clothing, and gloves. 
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System Views 
 

 

 
 

 



 

 

 16 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

 

 

 

 

 

Installation and System Operation  
 



 

 

 17 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

 

Overview 
 

To run Exicycler™ 96 Fast Real-Time Quantitative Thermal Block, camera driver and operation software 

should be installed in a computer. When first installing the camera driver and operation software, or re-

installing these components, please see below for instructions on how to install them. 

 

Site Requirements 
 

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block is for an indoor use. Ensure that the 

installation site: 

– Meets the spatial and weight requirements.  

– Meets environmental requirements.  

– (The instrument) Is within 1.5 m (4.92 ft) of a 800VA power receptacle.  

– (The computer) Is within 1.5 m (4.92 ft) of a 500VA power receptacle. 

– Is away from water. 

 

Required Materials 
 

Scissors, pocket knife, or box cutter 

 

Unpacking Exicycler™ 96 Fast 
 

  
Save the packing materials and box in case you need to ship the instrument to Bioneer for service. 

 

1) To unpack Exicycler™ 96 Fast: 
 

 

 

 

 

 

 

 

 

 

 

a) Cut the straps securing the instrument box. 

b) Cut the tape securing the top flaps of the instrument crate, then open 

the flaps. 

c) Remove Exicycler™ 96 Fast accessories from the instrument and set 

them aside. 

d) Lift and remove the cover from the instrument crate. 

e) Remove the packing material from Exicycler™ 96 Fast, and then 

inspect the instrument for shipping damage. 

 

 

  
If Exicycler™ 96 Fast is damaged, note location and appearance of the damage, and then contact 

Bioneer Technical Support or your service representative. 

 

2)  Move Exicycler™ 96 Fast to the desired installation site. Follow these guidelines for lifting and 

moving: 

– Make sure that you have a secure, comfortable grip. 

– Keep your spine in a neutral position. 

– Bend at the knees and lift with your legs. 
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– Do not lift and twist your torso at the same time. 

3)  Open the box containing Exicycler™ 96 Fast accessories, then verify that it contains all the 

necessary components: 

– Refer to Component Lists. 

 

Setting Up the Computer 
 

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block operates through a computer. Therefore, to 

install Exicycler™ 96 Fast, a computer or a laptop is necessary. Computer must meet the following 

requirements listed below. Please contact Bioneer Customer Service Center if you have any questions 

regarding installation. 

 

Computer Requirements 

–  Intel Dual Core E2160 (1.8GHz) or higher 

–  Windows 7 Operating System for Korean or English Version (Service pack 1 or later, 32-bit OS 

only ) 

–  1.0GB RAM or higher 

–  1280 * 1024 screen resolution 

–  USB 2.0 high speed port 

–  20GB Hard disk drive minimum 

–  Microsoft Excel (Option) 

 

For questions regarding problems with the computer or operating system, please contact the computer 

manufacturer. 

 

1) The computer must have at least one communication port for USB data transfer. 

2) It is recommended to install an anti-virus software in order for Exicycler™ 96 Fast to operate safely. 

A firewall should also be setup to prevent unwanted information coming in from external networks. 

Please contact your IT department to setup anti-virus software and firewall. 

3) It is not recommended to insert a flash drive into USB port when Exicycler™ 96 Fast is running. It 

may cause a technical problem between Exicycler™ 96 Fast and the computer. 

 

Connecting the Computer and Exicycler™ 96 Fast 
 

There are main power connector and a communication port connector (USB) in the rear of Exicycler™ 

96 Fast. The computer should be turned off when connecting to Exicycler™ 96 Fast to prevent any 

damages to the communication port. Please see below for instructions on how to connect Exicycler™ 

96 Fast to the computer. 

 

1) Unpack Exicycler™ 96 Fast and make sure all components are included.  

2) Exicycler™ 96 Fast must be installed in an area where it is not exposed to sunlight and must be set 

on a stable and level surface. 

3) Set up the computer at the installation site. 

4) Place Exicycler™ 96 Fast in the installation site carefully. 

5) Connect USB 2.0 cable to USB connector on the back of Exicycler™ 96 Fast, then to the computer. 

6) Connect power cable to Exicycler™ 96 Fast, then to the receptable wall circuit. 
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Installing the Operation and Analysis Program  
 

To run Exicycler™ 96 Fast Real-Time Quantitative Thermal Block, the operation software and the 

camera driver must be installed in the computer. When installing the operation software and the camera 

driver for the first time, or re-installing these components, please see instructions below on how to 

install them yourself. In case of running the software for only data analysis purpose, please refer to this 

section for software installation. 

 

IMPORTANT: 

Do not turn on Exicycler™ 96 Fast unless you have installed the Operation and Analysis Program and a 

camera driver. First install the Operation Software and then the camera driver. 

 

To install Bioneer Package and Exicycler4 softwares for an ExicyclerTM
 96 Fast device under Windows 7, 

follow the instructions below: 

 

 If a previous version of software has been installed on your computer, please remove the programs 

and folders from the computer (Refer to ‘Troubleshooting, 4. The Bioneer Package is not installed 

correctly’). Remaining program folders may cause errors during installation. This section is for the 

first time installation or re-installation of the software. 

 The Bioneer Package has to be installed prior to installing Exicycler4 software. The procedures of 

Bioneer Package installation is described below. 

 

Installing Bioneer Package 
 

 

1) Turn on the computer, but not Exicycler™ 96 Fast Real-

Time PCR machine. Place Exicycler™ 96 Fast installation 

CD into the CD-ROM. Go to ‘Bioneer Package’ folder in the 

CD drive and run Setup.exe. 

 

2) To install Bioneer Package, click Next. The installation will 

proceed in C:\Bioneer_Package. 
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3) Enter desired name in the User Name box and Company 

Name box. 

 

4) Select a setup type to install. Complete is recommended for 

installing all program features. Custom installation is 

recommended only for advanced users. Click Next. 

 

5) InstallWizard is ready for installation. If you want to review or 

modify your settings, click Back. Click Install to start 

installation. 

 

6) This process takes several minutes. Please do not cancel 

until installation is complete. 

 

7) When installation is complete, please click Finish to finish 

installation Shield Wizard. 
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8) R program is also needed for Exicycler™ software. If you 

click OK, installation will begin. 

 

9) R program will be installed automatically. Please wait until 

installation is complete. 

 

10) Click OK for installing R(D)COM interface. 

 

11) R icon will be shown on the Desktop when installation is 

successful. 

 

12) The folders shown here are created after installation has 

finished. Please confirm ‘Bioneer_Package’ and sub folders. 
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Installing .NET Framework 1.1 Package  
 

 

1) In order to install ‘.NET Framework 1.1 Package’, run 

dotnetfx_eng.exe file of the C:\Bioneer_Package\Net11 

folder. 

 

2) Click Yes for installing ‘.NET Framework 1.1 Package’. 

 

 

3) A setup window asking about the license agreement is 

displayed. 

 

4) Select I agree to activate install button, Click Install to 

begin installation. 

 

 

5) All components related to .Net Framework are being 

installed.  

 

 

6) Installation of .NET Framework 1.1 is complete. Click OK 

to finish installation. 
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Installing Exicycler4 Software 
  

 

1) In Exicycler4 folder of the provided CD, you can see 

setup.exe file and double click InstallSheild Wizard to 

install required items automatically. 

 

 

2) Click Next and go to the next step. 

 

3) Click Install to begin installation. If you want to change 

any settings or cancel installing, click Back or Cancel. 

 

 

4) Please wait while InstallShield Wizard installs Exicycler4. 

 

 

5) Message indicating “InstallShield has successfully 

installed Exicycler4.” is shown. Click Finish to complete 

installation.  
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6) On the Desktop, these icons are created when installation 

is completed successfully. 

 

7) In the C:\Exicycler4\Run folder, folders and files that are shown on the image (below) are created. 

Copy ‘Calibration’ folder from ExicyclerTM
 96 Fast CD into C:\Exicycler4\Run folder. 

 

 

8) Now you should connect ExicyclerTM
 96 Fast system to a computer using provided USB cable.  

 

9) Check the USB cable connection between the Exicycler™ 

96 Fast and the computer. 

 

10) Turn on Exicycler™ 96 Fast. The status LED will be blue 

when the power is supplied properly.  

 

11) Press the power button for a second to start self-

diagnosis. The status LED will start blinking in green after 

two short beeps when the self-diagnosis is complete.  

 

 
 

 

 

12) When Exicycler™ 96 Fast is turned on for the first time, 

the computer searches for a new device. 

 

13) When an unsigned device is connected, the following 

message will be displayed. Click the message to view 

details. 
 

14) This message appears because device driver software is 

not installed yet. Driver must be installed in order to 

continue. Please click Close. 

 

15) To install device driver and to confirm device status, go to 

Control Panel\System and Security\System - Device 

manager. 
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16) All devices connected to computer are displayed. 

Unsigned device is indicated with an exclamation mark. 

Point at this device and right-click and select Update 

driver software. 

 

 

17) When a prompt searching for device driver is presented, 

select Browse my computer for driver software. 

 

 

18) Click Browse to search for the appropriate driver software. 

 

 

19) Select C: \Bioneer_Package\driver and click OK. 

 

 

20) Select Install. Installation will start automatically. 

 

 

21) Please wait while installing. This process takes several 

minutes.  
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22) A message indicating that the installation is successful 

will show when installation is complete. Click Close to 

complete installation. 

 

 

23) Open ‘Device Manager’ and confirm that device driver has 

been installed. If USB test devices (PLX)\PLX’Transfer 

device’ VID_0525&PID_1000) using Ncbulk.SYS has been 

installed properly, connected USB will be indicated. 

 

 

24) Click Run Exicycler4 icon to start ExicyclerTM
 96 Fast 

software. 

 

 
 

25) You can see this screen when installation is completed 

successfully. The software version is also indicated. 

 

26) Now you are ready to operate ExicyclerTM
 96 Fast system.  
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Troubleshooting 
 

1. Appropriate calibration data does not exist  

 

 

1) CD provided with Exicycler™ 96 Fast has Calibration data 

for each device. Calibration data have to be copied into 

C:\Exicycler4\Run folder in order for a normal function. If 

Calibration folder does not exist on this path, following 

message will be displayed.  

 

2) Click OK to change the path. 

 

3) You should assign the path of the Calibration folder to be 

copied automatically. Click Open and you will see the 

following browser. 

 

 

4) After assigning the Calibration folder (ex. E: \Calibration), 

click OK.  

 

 

5) Copy Calibration window displays the path of Calibration 

folder and serial number of your device. If the serial 

number matches with the connected ExicyclerTM
 96 Fast 

system, click Copy button on the right hand side of 

window.  

 

6) Please wait for a few minutes to complete. 

 

7) When copying calibration folder is complete, click OK to 

finish the process. Please confirm the connection between 

device and computer, and restart Exicycler4 software. 
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2. The computer does not register ExicyclerTM 
96 Fast when launching ‘Run Exicycler4’ software.  

 

 

This message means that the device is not turned on or the 

appropriate device driver has not yet been installed on the 

computer. If you see this message despite the instrument is 

turned on, then you should re-install the device driver to solve 

this problem. The driver installation steps are described in 

‘Installing Exicycler4 Software’ section. 

 

3. An Error message is displayed when lunching ‘Run Exicycler4’ software.  
 

 

This message indicates that ‘.NET Framework 1.1’ has not yet 

been installed. Go to ‘Installing.NET Framework 1.1 Package’ 

section and re-install as described. 

 

4. The Bioneer Package is not installed correctly. 
 

If an incorrect installation was performed previously, ‘Bioneer Package’ may not be installed correctly. 

Go to Control Panel-Programs Add/Remove and remove 4 programs from the computer - ‘Exicycler 96 

V4 4.0’, ‘Bioneer package’, ‘R for windows 2.11.1’ and ‘R/Scilab(D)COM Server3.01-B5’. After 

removing them from the computer, repeat the entire installation process. 
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Turning On and Self-diagnosis 
 

1) Turn on Exicycler™ 96 Fast by switching on the main power switch in the rear of the instrument. 

When power is supplied properly, a status LED turns blue.  

 

2) Press the POWER button for a second to start self-diagnosis.  

 

3) When the status LED is blinking green, you can either open or close a main door by pressing a 

DOOR button for a second. The status LED is blinking in purple when the door is open and is back 

to green when the door is closed. 

 

Power Off            Power On          Door Open            Stanby 

 

IMPORTANT:  

The status LED starts blinking green after two short beeps when the self-diagnosis is complete. 

Exicycler™ 96 Fast is now ready to operate. The status LED will turn red when the self-diagnosis fails 

or excessive physical shock is applied from outside. (e.g. Make sure that there are no objects placed 

in front of the door) Make sure that the status LED is blinking green before operating Exicycler™ 96 

Fast to prevent mis-operation or damage. A result of the self-diagnosis is provided under “ExiConfig”. 

 

※ Status LED color 

a. Red: Error 

b. Blue: Standby 

c. Green: Ready for running 

d. Yellow: Self test 

e. Cyan: Running 

f. Purple: Door open 

g. White: Pause 

 

NOTE:  

You can stop the operation here and turn off the Exicycler™ 96 Fast by pressing the POWER button for 

a second when it is blinking in green like Step 3. 

 

  
Do not place any obstacle in front of the system and do not load a plate or take it out when the door 

is moving. It can cause serious damage and lead to severe injury. 
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Running Real-Time PCR Using Exicycler™ 96 Fast Software 
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Starting ‘Run Exicycler4’ program 
 

 

1) Ensure that Exicycler™ 96 Fast is in the “Standby” 

mode. The status LED must be blinking green. Double 

click Run Exicycler4 icon on the desk top to start Run 

Exicycler4.  

 

 

2) System Check window will pop up. 

 
 

IMPORTANT:  

The following error message will appear if Exicycler™ 96 Fast is not 

turned on. Turn on Exicycler™ 96 Fast by pressing the power switch at 

the back of Exicycler™ 96 Fast and the power button in front of 

Exicycler™ 96 Fast. Then double click Run Exicycler4 icon on the 

desktop again. 

 
 

IMPORTANT:  

The following error message will appear when the calibration has not been 

performed for Exicycler™ 96 Fast or the calibration data is not present. 

Close Run Exicycler4 program and copy calibration folder into 

C:\Exicycler4\Run. (The CD provided with Exicycler™ 96 Fast has 

calibration data for each device.)  

3) The following window will appear when System Check is complete. 

a. Menu consists of File, Setup, Run, 

Window, and Help. 

 

b. Experiment Information displays file 

name, user name, and elapsed 

and estimated finish time. 

 

c. Protocol Information displays a 

cycling protocol in detail. 

 

d. Well information displays sample 

and probe specification for each 

well. 

 

e. Temperature Profile displays a 

temperature curve of the cycling 

protocol. 
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4) Go to Setup > Probe from the top menu. 

 

 

IMPORTANT:  

9 different probe options are available in Exicycler™ 96 Fast. Each probe option includes 

specifications for a fluorescence dye and a quencher. You can either select one of existing probe 

options in Probe List or add your own. Ensure you specify an appropriate probe option for accurate 

data analysis. 

 

5) Probe Information window will appear. Select one or click 

Add to add additional probe. 

 

* Additional Probe Setting: 

ex) Enter ‘b-actin’ in the field 

 

NOTE: 

For example: In the Dye drop-down list of the Add Probe window, select SYBR_Green. Select None 

in the Quencher drop-down list. Select your desirable color for display and then click OK. 

 

6) Check if your new probe is shown under the list, and then 

click Save. 

 
 

 

7) Go to File > Design Experiment to design a new 

experiment. 
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8) Quick Start window will appear as shown below: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Master, Protocol, and Plate: You can create, save, or open a file. 

b. User: Select or create the user name for personal account management. 

c. Protocol Information: Displays a cycling protocol in detail. 

d. Temperature Profile: Displays a temperate curve of the cycling protocol. 

e. Protocol Setting: Specifies protocol specifications such as temperature, time, and a number of 

cycles. 

 

 
 

 

NOTE: Example of qPCR protocol  

SYBR Green I TaqMan probe 

 
 

c. Protocol Information  

d. Temperature Profile e. Protocol Setting 

a. Master, Protocol, Plate 

  
b. User 
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9) Click Incubate tab and enter a temperature in the Temperature field and then a time in the Time field. 
 
 
 
 
 
 
 

 

 

 

a. Incubate sets up a temperature and a time for the thermal block. 

Time Increment sets up time increment per cycle. 

Temperature Increment sets up temperature increment per cycle. 

Ramping Rate reduces a ramping rate. 

b. Scan measures fluorescence signals emitted from samples. 

c. Goto specifies a starting step of a thermal cycling and a number of cycles. 

d. Melting sets up starting temperature and ending temperature for melting curve analysis to 

distinguish specific and nonspecific amplification products when SYBR Green is used for Real-

Time PCR. 

e. Gradient is used to evaluate an optimum annealing temperature condition for amplification. 

f. Store keeps the 96-well thermal block at a set temperature until you stop Exicycler™ 96 Fast. It is 

not recommended to use Store step when it is excessively humid. 

g. Pause is used to pause Exicycler™ 96 Fast when it is necessary to check samples during 

experimentation. The door of Exicycler™ 96 Fast will open when the Pause step is inserted in the 

protocol file. Click Run to resume the experiment. 

h. Hottop sets up a temperature for the heating lid. 
 

NOTE: 

Scan is used to detect fluorescence signals from samples. The fluorescence signals are measured while 

maintaining the temperature of the previous incubation step. If the Scan step is not included in the 

protocol file, a conventional PCR will be carried out without scanning fluorescence signals. 
 

Melting sets up starting and ending temperature for melting curve analysis to distinguish specific and 

non-specific amplification products when SYBR Green is used for Real-Time PCR. Enter starting 

temperature in the From field, ending temperature in the To field, a temperature interval within a range of 

0.1°C to 1.0°C in the Between field, and a hold time within a range of 1 second to 255 seconds in the 

Hold Time field. 
 

Gradient is used to select an optimum annealing temperature for amplification and programs a 

temperature gradient up to 20°C across the rows of a sample block. Enter starting temperature in the 

From field, ending temperature in the To field, and time within a range of 1 second to 5 hours 59 

minutes and 59 seconds in the Time field. 
 

Store keeps the 96-well thermal block at a set temperature when thermal cycling is complete. The 

heated lid will start cooling down automatically. Exicycler™ 96 Fast will keep the main door closed and 

will maintain thermal block at the set temperature until you stop Exicycler™ 96 Fast. If the Store step is 

not inserted into the protocol file, the main door will open automatically when the thermal cycling is 

done. 
 

Hottop Check Box sets up a temperature for the heating lid within a range of 90°C to 120°C. The default 

temperature is 105°C. When the check box is unselected, the heating lid will not be heated. 
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10) Click Append to add a new step into the protocol. 
 

a. Append button is used when you want to add new 

steps into the protocol. 

b. Update button is used when you want to make 

changes to a selected step. 

c. Delete button is used when you want to delete a 

selected step from the protocol. 
 

 

 

11) Click Incubate tab to add another Incubation step and 

then click Append. Repeat steps 9 through 10 if 

needed. (i.e. 94°C 30 sec / 55°C 30 sec / 72°C 30 

sec). 

 

NOTE:  

To edit Incubate steps, click one of the steps in the Protocol Information window and edit. Click Update 

to change the protocol. 

 

12) Click Scan tab and then Append. 

 

 

13) Click Goto tab and select a starting step (i.e. “2”) in the 

Line drop-down list. Enter a number of cycles (i.e. “40”) 

in the Cycle field, and then click Append. 

 

NOTE: Melting curve analysis 

Melting curve analysis is an assessment of the dissociation-characteristics of double-stranded DNA 

during heating. 
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14) Click Melting tab to perform melting analysis. Enter 

starting temperature in the From filed (i.e. “60”), ending 

temperature in the To field (i.e. “94”), a temperature 

interval in the Between field (i.e. “1”), and a hold time in 

the Hold Time field (i.e. “1”). 

 

15) Click Append. 

 

16) Click Incubate to add finish step (i.e. 25°C 1 min 30 sec) 

and then click Append. 

 

 

NOTE:  

The door of Exicycler™ 96 Fast will open automatically when a Real-Time PCR protocol does not 

include Store step. If Store step is included in the protocol, you must stop Exicycler™ 96 Fast by 

clicking Stop button in order to open the door. Otherwise, Exicycler™ 96 Fast will continue to store 

samples in the thermal block at the set temperature. 

 

IMPORTANT: 

To set the temperature on the Hot top Make sure that the Hottop check box is selected. The default 

value is set to 105 ℃. If you turn off the Check box hot top is not heated. 
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Additional: Setting the temperature gradient mode  

① Click Gradient tap, enter starting temperature in the From field, ending temperature in the To 

field.  

 

 

② Press ‘Gradient Calculator’ button below the time setting window, and ‘Gradient Calculator’ 

window will appear. It will show predicted temperatures on each well.  

 

③ Click Append. 

 



 

 

 38 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

 

17) Enter a protocol file name in the Protocol field at the 

top left (i.e. “test”) and then click  button to save 

the protocol. 

 

 

NOTE: 

Click  button from the Quick Start to open the saved Master, Protocol and Plate files when needed. 

 

18) Once the protocol is saved, click Plate tab to create a plate file. Plate window will appear as 

follows: 

 

a. 96-well plate position specifies well locations for samples. 

b. Name/Count/Probe displays a name and probe information for each sample. 

c. Probe Name/Flu. Dye/Quencher/Type/Concentration specifies a name, a fluorescence dye, a 

quencher dye, a type, and a concentration for each sample. 

d. Protocol/Plate tab switches between the Protocol Information and the Plate Information windows. 

e. Sample Name enters a sample name. 

Assign specifies the information of each well such as probe and type. 

Add Probe adds the probe to be used in experiment. 
 

NOTE:  

Ensure that you specify appropriate information (i.e. probe set up and sample type) for each well before 

running experiment in order to generate accurate data. 
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19) Click Add Probe, the Add Probe window will appear. 
 

 
 

20) Select appropriate probes, and then click OK. 

 

a. Probe Name: displays probe name assigned by the 

user. 

b. Fluorescent Dye: displays name of a fluorescence dye 

assigned by the user. 

c. Quencher: displays name of a quencher assigned by 

the user. 

 

21) The probe is loaded and shown as follows: 
 

 

22) Select wells from the 96-well plate diagram. 

 

 

 
 

NOTE:  

Use the left mouse button when selecting a single well. When selecting a range of cells, click the first 

cell in the range, and then drag to the last cell. You can also select cells in a row or column by 

pressing CTRL and clicking the row or column heading. To select all cells in 96-well plate, click the cell 

 at the top left corner of the diagram.  
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23) Click the probe option cell and then select STD in the Type drop-down list. Select the check box of 

Probe Name and then click Assign. 

 

a. Sample represents unknown samples. 

b. STD stands for a standard sample of a known concentration.  

c. NTC stands for No Template Control and is a sample without a template. 

d. IPC stands for Internal Positive Control and is a sample that monitors the PCR run during 

Existence / Non-existence reaction. It will also diagnose cause of the negative result from 

PCR. 

e. IPC- is a sample that is used as a template and contains a reagent to prevent the IPC 

reaction during Existence / Nonexistence reaction. IPC- is not amplified during the Real-

Time PCR. 

24) For example, Click well D3 and enter ‘1000000’ for a concentration of 10
6
-copy and then click 

Assign. Repeat this for wells D4 through D8 with concentrations of serial diluted standards. 

 

25) Select wells E3 through E8 in the plate diagram. Select Sample in the Type drop-down list, and the 

click Assign.  
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26) Select cells D3 through E8 and enter a sample name in the Sample Name field. Click Sample Name 

to save sample name. 

 

27) Verify information on each well in the Name/Count/Probe window. 

  

28) Enter a plate name in the Plate field (i.e. Test) and then click  button to save the plate file. 
 

29) The protocol file and plate file are saved. Enter a master file name in the Master field (i.e. Test) 

and then click  button to save the master file. 

 

 
 

NOTE:  

Save the master file, the protocol file, and the plate file by clicking  button. You can open the saved 

master file by clicking  button from Quick Start menu. The master file includes both protocol and 

plate file. 
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30) Click OK at the top right corner. Go back to the main 

window. 

 

Power off 

 

Standby 

 

 

31) Ensure the status LED in front of the Exicycler™ 96 Fast is 

blinking green. 

 

 
 

32) Press the DOOR button for a full second to open the door. 

Load the 96-well plate with A1 positioned at top-left 

corner of the block. 

 

33) Verify the master file and go to Run > Run from the top menu bar or click the Run button. 

 

 

34) Enter a data name (i.e.Sample_AQ) in the Dataname 

window and click Ok. If you do not enter the data name, 

default name will be used. 
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35) The following three message boxes will appear in the following order. 

 

a. This message will appear when closing the door of the 

Exicycler™ 96 Fast. 

 

b. This message will appear when the lamp condition is 

being checked. 

 

c. This message will appear during lamp ignition. 

 

d. This message will appear when lamp is turned on and 

initialization of Exicycler™ 96 Fast. 

 

 

36) The main window will appear when the progress bar finishes without any problems. 

 

a. Scan window displays a curve of amplification in real time during PCR. 

b. Melting windows displays a melting curve in real time when the melting step is included in the 

protocol file. 

c. Temperature Profile displays a temperature profile and in real time. 

d. Experiment Information displays information of the current experiment. 

e. Protocol Information indicates current progress of the experiment. 

f. Well Information displays details of each well when selecting either Probe or Type in the Graph 

Color Setting drop-down list. To display the curve of amplification, select a well from 96-well 

plate diagram and click the check box from the probe option. 
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37) Go to Run > Stop to stop Exicycler™ 96 Fast or click Stop 

button. 

 

 

38) Go to Run > Pause to pause Exicycler™ 96 Fast or click 

Pause button. 

 

 

IMPORTANT:  

If the pop up window remains more than 5 minutes after running Exicycler™ 96 Fast or if the 

temperature profile does not display anything in the main window, turn off Exicycler™ 96 Fast and turn it 

on again. Start Run Exicycler4 again and run Exicycler™ 96 Fast again. If the same error keeps 

occurring, please contact us for customer service. 

 

IMPORTANT:  

It is recommended to re-start Exicycler™ 96 Fast at least 10 minutes after the previous Real-Time PCR 

run has finished. Continuous operation without a break will reduce the lamp life span and cause errors. 

 

NOTE:  

Do not turn off Exicycler™ 96 Fast while the heating lid is warming up. While the lid is heated to the set 

temperature, 96-well block maintains at 25°C. The thermal cycling will start when the heating lid 

reaches set temperature and the lamp is stabilized. 

 

NOTE:  

*.ex3 file is created under a folder designated by the user after the experiment is complete. The user 

can analyze the *.ex3 file using Exicycler™ 96 Fast Analysis Program to generate analysis data. Please 

refer to Analyzing Data using Analysis Program for data analysis. 
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Reagents and Consumable Products 
 

Various reagents and kits are required to perform a Real-Time PCR in Exicycler™ 96 Fast Real-Time 

Quantitative Thermal Block. Please refer to this section to obtain detailed information about the appropriate 

reagents and kits for your experiments. For ordering, please go to the 71 page, Ordering Information. 

 

PCR MasterMix kit 

AccuPower® 2X Greenstar™ qPCR MasterMix allows an easy and fast amplification in Exicycler™ 96 Fast. 

AccuPower® 2X Greenstar™ qPCR MasterMix consists of Sybr
®
 Green I fluorescent dye, DNA polymerase, 

and necessary qPCR components.  

 

Optical 0.1 ㎖ low profile 8-strip tube and 96-well low profile plate 

You must use an optical tube or a plate when 

performing Real-Time Quantitative PCR in 

Exicycler™ 96 Fast. A standard tube or a plate can 

be also used, but only for a conventional PCR 

without fluorescent dyes. 

 

 

Optical sealing tape 

Seal up the optical tubes or plates tightly with the 

optical sealing tape for fluorescence detection. The 

sealing tape is available in the size of 96-well low 

profile plate. Therefore, cut up the sealing tape 

when using 0.1 ㎖ low profile 8-strip tubes. 

 

 

 

 
You must cut up the sealing tape with a box cutter, not scissors. The tape adhesive can be carried over 

to the surface of sealing tape when cutting up the tape with scissors. This will make the tubes stick to 

the heating lid of Exicycler™ 96 Fast. Tubes stuck to the lid will drop inside Exicylcer™ 96 Fast when the 

lid is cooled down. Using at least 2 strips of 8-strip tubes at a time is recommended to prevent this 

error. 

 

 Chemical hazard:  

AccuPower® 2X Greenstar™ MasterMix may cause eye and skin irritation, and respiratory tract irritation. 

Read MSDS before use and follow the instructions if swallowed or inhaled. Wear appropriate protective 

eyewear, clothing, and gloves. 
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Performance Maintenance 
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Performing System Diagnosis using ExiCfg 
 

 

1) Turn on Exicycler™ 96 Fast by pressing the POWER button. 

 

 
 

2) Go to ‘C:\Exicycler4\Run’ and double click ExiCfg.exe to 

start the program. 

 

3) Go to Information > Self Test. 

 

NOTE: 

‘USB Communication is NOT initialized’ message box will pop up if Exicycler™ 96 Fast is turned off or if 

the cable connection between Exicycler™ 96 Fast and the computer is not firmly connected. 
 

 

 

 

4) Click Start in the Self Test window. 

 

IMPORTANT:  

Make sure that there are no objects placed in front of the door while performing Self Test. 
 

POWER button 
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5) OK signs will show up in green, when all of the self-

diagnosis tests pass completely without any problems. 

 

NOTE:  

Self-diagnosis is complete with two short beeps. 
 

 

 

 

6) When any of the self-diagnosis tests fail, NG signs will 

appear in red. 

 

 

 

NOTE:  

Any problems caused during self-diagonsis are recorded in ‘Error log’. 

7) Go to Information>Error Log from the top menu bar to see the problems. 

 

 

 

 

 



 

 

 49 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

Guide to AccuPower® Fluorescence test kit for calibration 
 

Prepare to perform the calibration with a Fluorescence test kit. The Fluorescence test kit is designed for 

Exicycler™ 96 Fast Real-Time Quantitative Thermal Block. Therefore, it is not applicable to other Real-

Time instruments. The Fluorescence test kit is comprised of 11 plates, a mask fluorescence test plate, 

a background fluorescence test plate, multi-channel fluorescence test plates (9 different optical 

Fluorescence test plates of filter sets) present in Exicycler™ 96 Fast. The Fluorescence test kit is 

available for reuse up to 3 times. For more information about the Fluorescence test kit, please see the 

following: 

 

Before Starting Calibration with the Fluorescence test kit  
 

Centrifuge, Disposable plastic gloves, AccuPower® Fluorescence test kit for Exicycler™ 96 Fast (A-2060-

A2) 

 

Fluorescence test plate preparation 
 

The Fluorescence test kit is shipped refrigerated or frozen and must be stored in the freezer upon receipt. 

Retrieve one Fluorescence test kit right before starting the calibration. 

 

   

1) Take out the Fluorescence test kit from the freezer. 

 

 

2) Take out a sealed packs in the Fluorescence test kit. 

 

 

3) Allow the pack to thaw in room temperature for at least 10 

minutes. 

 

 

4) Take out a Fluorescence test plate from its packaging. 

 

IMPORTANT:  

Pay particular attention to the Fluorescence test kit when handling. Wear disposable plastic gloves 
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to prevent contamination on the sealing tape covering 96-well plate. Wipe the surface of the plate 

with 70% ethanol when it needs to be cleaned. 
 

 

NOTE:  

Do not vortex the Fluorescence test plate. A small amount of Fluorescence test solution is pre-aliquoted 

in each well, and it may be lost while vortexing. 

 

 

5) Place the Fluorescence test plate in a rack and 

centrifuge for 5 minutes. 

 

NOTE:  

It is important to centrifuge the Fluorescence test kit prior to use. This will spin down remains of 

fluorescence dye on the side of the well and to remove air bubbles at the bottom of the well. 
 

  

6) Protect the Fluorescence test plate from direct sunlight 

after centrifugation. Place the plate directly into  

Exicycler™ 96 Fast. 

7) Put the Fluorescence test kit back into its packaging and return it to the freezer when the calibration 

is done. 

IMPORTANT:  

The Fluorescence test kit contains photosensitive components. Keep the Fluorescence test kit away 

from light during calibration. Put the Fluorescence test plate back into its packaging right away for 

reuse. 
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Calibration using ExiCfg 
 

The calibration must be performed prior to operating Exicycler™ 96 Fast Real-Time Quantitative Thermal 

Block. You can either transfer proper calibration data associated with a serial number from the 

installation CD to the computer or perform the calibration yourself. Install the Operation and Analysis 

Software for the calibration data transfer to the computer. For a reliable operation of the Exicycler™ 96 

Fast, calibrating Exicycler™ 96 Fast with a Fluorescence test kit is recommended. Calibration must be 

done when moving Exicycler™ 96 Fast to a different location or when changing a light source lamp. A 

periodical calibration of every 6 months helps to maintain the optimum condition of Exicycler™ 96 Fast. 

Use the ExiCfg program to calibrate Exicycler™ 96 Fast. The ExiCfg calibrates as well as 

diagnosessystemical condition of Exicycler™ 96 Fast. Make sure that you are fully trained for handling 

the ExiCfg before starting calibration. Otherwise, authorized staff is only allowed to manage the ExiCfg. 

Mis-use of the ExiCfg by unauthorized staff may cause serious damage to Exicycler™ 96 Fast. 

The calibration is carried out in 4 steps, Warming up the lamp > Mask calibration > Background 

calibration > Multi-Channel calibration. 

 

Mask Calibration 
 

 

1) Turn on Exicycler™ 96 Fast by pressing the POWER 

button. 

NOTE:  

Make sure the status LED is blinking green after the self-diagnosis prior to starting the Calibration. 
 

  

 

2) Go to ‘C:\Exicycler4\Run’ and double click 

ExiCfg.exe. 

 

POWER button 
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3) Click Lamp warming to turn on the lamp. A 

progress bar of the Lamp warming will start right 

after ‘The lamp is turned on’ message appears on 

the ‘History’ box. Do not click any buttons until the 

progress bar finishes. 

 

IMPORTANT: 

It usually takes about 30 seconds for the message ‘The lamp is turned on’ to appear on the ‘History’ 

box. If the message does not appear in 3 minutes, turn off Exicycler™ 96 Fast and turn it on again after 

5 seconds. In case of an abnormal shutdown like this, wait about 3 minutes, then click Lamp warming 

to turn on the lamp again. It takes approximately 10 minutes to reach the maximum light intensity there 

after. Therefore, wait until the progress bar of the Lamp warming finishes before proceeding further. 
 

 

 

4) Press the DOOR button to open the door. 

 

 

5) Place the Mask Fluorescence test plate on the 

block. 

NOTE:  

You must perform the Mask Calibration test prior to any other calibrations. 
 

IMPORTANT: 

It is important to load the Fluorescence test plate in the right position. A misplaced plate may cause 

damage or technical problems. 
 

Door button 
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6) Press the DOOR button again to close the door. 

 

 

7) Click Mask Calibration button. 

 

8) Click Start button in the ‘Mask Calibration’ window.  

 

NOTE:  

The Calibration time is approximately 10 minutes depending on the condition of Exicycler™ 96 Fast and 

the computer. 
 

 

 

9) When the Mask Calibration is complete, click OK. 

 

NOTE:  

The door will open when the Mask Calibration is successfully completed. Put the plate back into its 

packaging and return it to the freezer. 
 

Door button 
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 High temperature 

Wait at least 5 seconds before taking out the Fluorescence test plate from the 96-well block. The 

Fluorescence test plate is heated to a temperature of 100°C and may cause a burn. 
 

 

10) Click Close in the ‘Mask Calibration’ window. 

 

11) The ‘Mask Calibration’ frame will turn blue when the 

Mask Calibration is completed. 
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Background Calibration 
 

 

1) Press the DOOR button to open the door. 

 

NOTE:  

This step is omissible when performing the Background Calibration followed by the Mask Calibration. 
 

 

2) Place the Background Fluorescence test plate on 

the block. 

IMPORTANT:  

It is important to load the Fluorescence test plate in the right position. A misplaced plate may cause 

damage or technical problems. 
 

 

3) Click Background Calibration button. 

 

 

4) Click Start in the ‘Background Calibration’ window. 

Door button 
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NOTE: 

The Background Calibration takes approximately 10 minutes depending on the condition of Exicycler™ 

96 Fast. 
 

 

 

 

5) When the Background Calibration is complete, click 

OK. 

 

NOTE:  

The door will open when the Background Calibration is successfully complete. Put the plate back into its 

packaging and return it to the freezer. 
 

 High temperature 

Wait at least 5 seconds before taking out the Fluorescence test plate from the 96-well block. The 

Fluorescence test plate is heated to a temperature of 100°C and may cause a burn. 
 

 

 

 

6) Click Close in the ‘Background Calibration’ window. 

 

 

7) The ‘Background Calibration’ frame will turn blue 

when the calibration is completed. 

 



 

 

 57 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

Multi-channel Calibration 
 

 

1) Press the DOOR button to open the door. 

NOTE: 

This step is omissible when performing the Background Calibration followed by the Mask Calibration. 
 

 

2) Click Multi-Channel Calibration button. 

 

 

3) Select fluorescence dyes in the ‘Multi-Channel 

Calibration’ window for the Calibration. 

 

NOTE:  

9 dyes are available for calibration. 
 

NOTE:  

For a selective multi-channel calibration of your desirable dyes, select check boxes of the dyes. 
 

Door button 
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4) Click Start. 

 

5) Prepare the Multi-Channel Fluorescence Test plate with a 

dye X (i.e. “FAM”) when ‘Attach the plate named ‘X’ (i.e. 

“FAM”) on the bath’ message appears. 

 

6) Place the Multi-Channel Fluorescence Test plate on the 

block. 

 

IMPORTANT: 

It is important to load the Fluorescence Test plate in the right position. A misplaced plate may cause 

damage or technical problems. 
 

 

7) Click Yes in the ‘Confirm’ window. 

 

8) The door will open when the Calibration is successfully 

complete. 

NOTE:  

An approximate calibration time for each dye is 5 minutes. 

 

NOTE:  

Put the plate back into its packaging and return it to the freezer. 
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 High temperature 

Wait at least 5 seconds before taking out the Fluorescence test plate from the 96-well block. The 

Fluorescence test plate is heated to a temperature of 100°C and may cause a burn. 
 

 

9) Prepare the Fluorescence Test plate with a dye X (i.e. 

“SYBR Green”) when ‘Attach the plate named ‘X’ (i.e. 

“SYBR Green”) on the bath’ message appears.  

 

10) Click Continue to repeat step 9. 

 

11) When the Multi-channel Calibration is complete, click 

OK. 

 

 

12) Click Close in the ‘Multi-Channel Calibration’ window. 

 

 

13) The ‘Multi-Channel Calibration’ frame will turn blue when 

the Calibration is completed. 
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14) Go to Calibration>Test Function>Lamp Off from the top 

menu bar. 

 

 

 

15) Go to Information>Exit from the top menu bar to close 

ExiCfg program. 

IMPORTANT: 

Wait at least 3 minutes to switch off main power of Exicycler™ 96 Fast. The cooling fan will continue to 

run to cool down the lamp. Shutting down Exicycler™ 96 Fast before cooling down the lamp will reduce 

the lamp life span. 

 16) Turn off Exicycler™ 96 Fast by pressing the POWER 

button.  

 

17) Turn off Exicycler™ 96 Fast using the main power switch 

located at the back of Exicycler™ 96 Fast. 

 

 

POWER button  

Main POWER switch 
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Cleaning the main body 
 

Note: 

 Turn off Exicycler™ 96 Fast Real-time Quantitative Thermal Block, then remove the power cord. 

 Allow the instrument to cool until the bath block reach room temperature. 

 

Cleaning the Block Wells 
 

If you use any cleaning or decontamination method, except those recommended in the manual, you risk 

damaging the Instrument. Clean the block wells once a weekly or as needed. 

 

  
Always wear protective glasses and gloves when servicing the instrument. Also, make sure you 

disconnect the instrument from power cord before you begin any service procedure. 

 

  
During instrument operation, the temperature of the bath block can be as high as 100°C. Before 

performing the procedure, keep hands away until the bath block reach room temperature. 

 

To clean the block wells: 
 

1) Open the Front door. 

 

2) Remove the sample from the bath block and set it aside. 

 

3) Use a cotton swab soaked in pure isopropyl alcohol or DNA Zap to clean the wells thoroughly. 

Make certain that the isopropyl alcohol or DNA Zap has evaporated completely before reloading a 

sample tray. 

 

 CHEMICAL HAZARD  

Isopropyl alcohol is a flammable liquid and vapor. Exposure may cause eye, skin, and upper respiratory 

tract irritation. Prolonged or repeated contact may dry skin and cause irritation. 

Exposure may cause central nervous system effects such as drowsiness, dizziness, and headache. 

Read the MSDS, and follow the handling instructions. 

Remove any remaining isopropyl alcohol from the cover. 

 

Note:  

If the platen becomes contaminated with amplified DNA, raise the hot-top cover to a cleaning position, 

wipe the platen with a cloth or cotton swab soaked in bleach, then rinse with water. 

1) Clean the heated platen once a month or as needed. 

2) If the hot-top cover becomes contaminated with amplified DNA, raise the hot-top cover to a 

cleaning position. Wipe the cover with a cloth swab soaked in Isopropyl alcohol or DNA zap, 

then wipe the cover with a damp cloth. 
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Precautions for PCR tube loading 
 

Do not put a tube column bias one if you experiment with PCR Strip tube. This can be caused by a 

phenomenon in skewing the Hot Lid cause evaporation of such samples, equipment failure. So please 

put the empty tube to balance the opposite direction. Please also well positioned for insertion into the 

correct PCR tube. If Tube is inserted incorrectly can not get the normal data, in this case, you must do 

the experiment again.  

      

 

 

 

 

 

 

 

 

 

 

 

Sample Empty tube 

PCR tube balancing 

Correctly located strip tube 

Incorrectly located strip tubetube 
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Replacing Fuses 
 

The instrument has two 250V, F10AL and 5×20mm fuses. 

 

Required Materials 
 

 Two 250V, F10AL and 5×20mm fuses  

 Small screw-driver(-) 

 

Procedure  
 

1) Turn off the instrument and disconnect the power cord from the back of Exicycler™ 96 Fast. 

 

 ELECTRICAL SHOCK HAZARD  

Severe electrical shock, which could cause physical injury or death, can result from working on an 

instrument with high voltage power supply. To avoid electrical shock, disconnect the power supply to the 

instrument, unplug the power cord, and wait at least 1 minute before working on the instrument. 

 

 

2) Insert a small screw-driver(-) into the slot in the upper portion of 

the power entry module, and open the fuse door.  

 

 

3) Pull out the fuse compartment to inspect the two fuses in the fuse 

compartment. 

 

 
 

 

4) Pull out the blown fuse(s) from the fuse compartment and replace 

with new 250V, F10AL, 5×20mm fuses. 

 

5) Place the fuse compartment back into the power entry module and 

close the fuse door. 

 

6) Press the fuse door until it locks in place. 

 

7) Connect the instrument power cord. 
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Returning Exicycler™ 96 Fast for Service 
 

1) Decontaminate the instrument. 

 

  
If the bath block became contaminated with radioactivity, use a commercially available decontaminant 

to remove the contamination. If the block is not decontaminated, the instrument cannot be returned to 

Bioneer for service. 

 

2) Complete certification for instrument decontamination. 

 

3) Fax or e-mail (exicycler-support@bioneer.com) the service request form to the customer center. 

 

4) Pack the instrument in the provided packaging, without any accessories or power cords. Include 

service request form in the box. 

 

Note:  

Request for instruments repair without the service request form can lead to delayed in service. 

 

5) Affix the provided postage to the box, then ship the instrument to the designated facility. The repair 

process requires 1 to 3 weeks.

mailto:exicycler-support@bioneer.com
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Troubleshooting 
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Please take recommend action for each observation. Contact Bioneer Customer Service Center if problem 

continues after the recommended action. 

 

Problems Recommended Action 

Exicycler™ 96 Fast does not 

start. 

1. Make sure the power cable is firmly connected to the wall circuit, 

and then switch on the power supply button at the rear of 

Exicycler™ 96 Fast. 

2. Check a fuse box located at the rear of Exicycler™ 96 Fast. 

Change the fuse if it has blown. 

Errors occur either after or 

during self-diagnosis (Status 

LED in red). 

1. The lamp may still be cooling down or the self-diagnosis is still 

running. If the status LED does not turn back to green in 3 

minutes, turn off Exicycler™ 96 Fast and turn it on again. If the 

same error occurs, please contact Bioneer Customer Service 

Center for help. 

2. Turn off Exicycler™ 96 Fast if unexpected errors occur. Turn on 

Exicycler™ 96 Fast again to cool down the lamp and wait for 3 

minutes. Press the POWER button to start self-diagnosis. Please 

contact Bioneer Customer Service Center if the same error keeps 

occurring. 

No communication detected 

between the computer and 

Exicycler™ 96 Fast. 

1. Make sure that the USB cable is firmly connected to the 

computer. 

2. Ensure you use the USB cable provided with Exicycler™ 96 Fast 

to connect the computer and Exicycler™ 96 Fast. 

3. Check if Exicycler™ 96 Fast is in the “Standby” mode. The 

status LED must blink in green. Turn off Exicycler™ 96 Fast and 

back on again if the status LED still blinks in red. 

The POWER button or the 

DOOR button does not work. 

1. Make sure that the power cable is firmly connected to the wall 

circuit, and then switch on the power supply button at the rear of 

Exicycler™ 96 Fast. 

2. The self-diagnosis may be still running. Wait until the self-

diagnosis is complete and the POWER button blinks in green. 

Exicycler™ 96 Fast has 

stopped running. 

1. Check if the electricity is supplied properly. Operate an AVR or 

UPS if needed. 

2. Disable Screen Saver and Monitor Power in the Control Panel. 

3. Ensure you use the USB cable provided with Exicycler™ 96 Fast 

to connect the computer and the Exicycler™ 96 Fast. 

4. Check if the USB driver is installed properly. If not, reinstall it 

again. 

5. Do not plug in any other USB cables in the computer while 

Exicycler™ 96 Fast is running to prevent friction between 

Exicycler™ 96 Fast and the computer. 
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Exicycler™ 96 Fast does not 

start a thermal cycling. 

1. Exicycler™ 96 Fast may still be in the “Standby” mode in order 

to warm up the lamp. Warming up the lamp takes about 10 

minutes. The thermal cycling will start automatically after the 

lamp warm up has finished. 

Intensity of fluorescence 

signal is low. 

1. Either examine fluorescence signal of the probe used for Real-

Time PCR or use a new kit. 

2. The PCR product amplified may be too long or there may be non 

-specific products. Perform gel electrophoresis to determine the 

presence of amplification product or adjust an annealing 

temperature or Mg2
+
 concentration if needed. 

3. Perform the calibrations again to adjust the light intensity of the 

lamp. 

Excessively high intensity of 

fluorescence signal. 

1. Adjust concentration of the probe used for Real-Time PCR. 

2. Make sure you use an appropriate probe system. 

3. Adjust and optimize the PCR sample conditions. 

The software shuts down 

abnormally. 

1. The USB driver is not been installed properly. Re-install the USB 

driver. 

PCR sample has evaporated. 1. Check if the heating lid works or if the sample tubes or plates 

are completely sealed with the sealing tape. 

2. Ensure the heating lid option is set up correctly. The Hottop 

Check Box must be selected and correct temperature must be 

set up. 

3. A small amount of evaporation is not critical. 

4. It is recommended that you use Bioneer kits and reagents to 

prevent PCR sample evaporation. 

No PCR products are 

amplified. 

1. Perform gel electrophoresis to determine the presence of 

amplification products. Adjust an annealing temperature or Mg2
+
 

concentration if needed. 

No fluorescent signal is 

detected although PCR 

product is amplified. 

1. Either examine fluorescence signal of the probe used for Real-

Time PCR or use a new intercalating dye. 

2. Perform the calibrations again to adjust the light intensity of the 

lamp. 

Pop-up message during 

calibration process. 

1. Background Calibration finished will appear if the Background 

Calibration is successful. 

2. Can't Read Data from EEPROM will appear if the computer 

cannot read data from Exicycler™ 96 Fast. Check if the USB 

cable is firmly connected between the computer and Exicycler™ 
96 Fast. 

3. Can't close program during PCR will appear if you attempt to 

close Exicycler™ 96 Fast software while PCR is still running. 
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Pop-up message during 

calibration process. 

(Continue) 

4. Do you want to stop PCR? will appear if you click Stop button 

during the Multi-channel Calibration. 

5. Did you add plate on the bath? will appear to make sure that the 

calibration plate is loaded in the thermal block prior to PCR. 

6. Mask Calibration finished will appear if the Mask Calibration is 

complete. 

7. Multi-Channel Calibration finished will appear if the Multi-channel 

Calibration is successful. 

8. Need to set up Machine ID will appear if an instrument ID has not 

been set up for Exicycler™ 96 Fast. Assign the ID using 

Exicycler™ 96 Fast software. 

9. No matching calibration data with machine will appear if the 

instrument ID does not match the ID from Exicycler™ 96 Fast 

software. Set up the instrument ID using Exicycler™ 96 Fast 

software. 

10. Turn off the lamp will appear if you attempt to end ExiCfg while 

the lamp is still on. To close ExiCfg, turn off the lamp first and 

then close the ExiCfg. 

11. Please load Mask Calibration Information first will appear if you 

attempt to perform the Uniform Calibration before the Mask 

Calibration. 

12. USB Communication is NOT Initialized will appear if the computer 

and Exicycler™ 96 Fast are not communicating with each other. 

Check if the USB cable between the computer and the 

Exicycler™ 96 Fast is firmly connected. 

13. You must insert New Dye Name will appear if a new name is not 

assigned to a custom dye. 

14. You must select at least one dye will appear if you start the 

Multi-channel Calibration without selecting dyes. You must 

select at least one fluorescent dye for the calibration. 

Error message when running 

Exicycler™ 96 Fast software. 

1. Can't exit program during PCR will appear if you click Stop button 

in Exicycler™ 96 Fast software while PCR is still running. 

2. Can't open data during PCR will appear if you select File > Open 

Data from the top menu while PCR is still running. 

3. Can't Pause during Melting Protocol will appear if you click Pause 

button while the melting step is still running. 

4. Can't read data from EEPROM will appear if errors occur during 

PCR and the computer cannot read data from Exicycler™ 96 

Fast. 

5. Can't read Plate Information will appear if you attempt to open 

an outdated plate file. 

6. Can't Stop during Melting Protocol will display if you attempt to 

stop the Exicycler™ 96 Fast software while the melting step is 

running. 
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Error message when running 

Exicycler™ 96 Fast software. 

(Continue) 

7. Communication between machine and S/W was not initialized will 

display if you click Run button when Exicycler™ 96 Fast is not 

ready. 

8. Do you want to stop PCR? will display if you click Stop button 

while PCR is still running. 

9. Fail to load calibration information will appear if the computer 

fails to read the calibration data from Exicycler™ 96 Fast. Go to 

C: \Exicycler4 to check if the calibration folder and file exist. 

10. Melting Protocol can't be in Cycle Region will appear if the 

melting step is inserted within a thermal cycling. 

11. Need to replace the Lamp will appear if the lamp intensity drops 

below 60% of the normal lamp intensity. Replace the lamp. 

12. No matching calibration data with Machine. Can't Run! will 

appear if you click Run button when Exicycler™ 96 Fast ID and 

the calibration data ID do not match. 

13. No matching calibration data with machine will appear if the 

Exicycler™ 96 Fast ID and the calibration data ID do not match. 

14. Please insert any protocol before inserting Goto Protocol will 

appear if the Goto step is inserted in the first line of a protocol 

file. 

15. Please insert Data name will appear if you have not entered a 

name for data prior to PCR running. 

16. Probe Information was changed, do you want to cancel this? will 

appear if you click the Cancel button without saving the edited 

probe Information. 

17. Probe using same filter is assigned will appear if you assign more 

than 2 probe options within the same wavelength range. 

18. Ramping rate option Must be inserted between Incubation steps 

will appear if you insert a ramping rate option in a wrong 

position of the protocol file. 

19. Set Probe Name will appear if you have not entered a new name 

for the custom probe in the Add Probe window. 

20. UserName was already in User List will appear when entering an 

existing name for User set-up. 

21. You must select Dye and Quencher will display if the dye and que

ncher set up has not been selected in the Add Probe window. 
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Ordering Information  
 

 

Product 

A-2060-2 Exicycler™ 96 Fast Real Time Quantitative Thermal Block 

Accessories 

A-2060-A2 AccuPower® 
Fluorescence test kit for Exicycler™ 96 Fast 

Plastic consumables 

3111-41 Adhesive Optical Sealing Film, 100 sheets 

3111-51 0.1 ml Opaque White 8-strip, Low Profile PCR Tube, 250 Strips 

3111-53 Opaque White 96-well Skirted, Low Profile PCR Plate, 25 Plates 

Premix & Reagent 

K-6253 AccuPower® 
2X Greenstar™ qPCR Master Mix / 100Rxn, 50 μL reaction 

K-6254 AccuPower® 
2X Greenstar™ qPCR Master Mix / 200Rxn, 50 μL reaction 

K-6603 AccuPower® Plus DualStar™ qPCR Master Mix(2X), 2.5ml, 100 rxn 

K-6703 AccuPower® RocketScript™ RT-qPCR Master Mix (2X), 2.5ml, 100rxn 
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WW aa rr rr aa nn tt yy  
 

 

This Bioneer brand product, as supplied and distributed by Bioneer Corporation, is warranted by Bioneer 

against manufacturing defects in materials and workmanship for a limited warranty period of one year. 

 

Product Exicycler™ 96 Fast Real-Time Quantitative Thermal Block 

Catalog No. A-2060-2 

Serial No.  

Date of Purchase      /      /       (dd/mm/yy) 

Warranty Period For 12 months from purchasing date 

 

 

1. How to request warranty service 

Please fill out the service request form attached to this manual and submit it to us by fax or mail. For prompt 

service, please have the problem log and the experimental file ready before contacting us. For more details, 

please contact Bioneer Customer Service Center or your local distributor. You may call us at +82-42-930-

8777 for minor problems. The service request result will be notified to you within 7 business days and the 

system will be repaired or replaced within 1~3 weeks. 

 

2. Repairs under warranty 

During the one-year warranty period, Bioneer will repair all defective products free of charge. 

 

3. Exclusion from warranty 

The product is excluded from warranty if: 

 The product has been found to be defective after expiry of the warranty period. 

 The product has been subjected to misuse, abuse, or unauthorized repair, whether by accident or 

other cause. 

 Product is damaged beyond repair due to natural disaster.



 

 

 73 

www.bioneer.com 

BQ-042-101-01 

Revision : 2 (2016-11-04) 

 

Exicycler™ 96 Fast / Real-time Quantitative Thermal Block 

 

 

SSeerrvviiccee  RReeqquueesstt  FFoorrmm  

Product Exicycler™ 
96 Fast Real-Time Quantitative Thermal Block 

Catalog No. A-2060-2 Serial No.  

Date of request  

Date of purchase  

Service 

 

Issue 

* Please list one service issue or concern per line 

Issue 1  

Issue 2  

Issue 3  

Issue 4  

Customer 

 

Information 

Name  

Company  

Name  

Contact Phone: Fax: 

E - mail  
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Revision History 
 

Rev. 

No. 
Rev. Date Reason Revision contents etc 

1.0 21/July/2014 First issue First description  

1.1 11/July/2016 
Document 

Form changes 
BQ-042-101-01 Rev.1 (2015-11-06)  

1.2 08/Dec/2016 
Document 

Form changes 
BQ-042-101-01 Rev.2 (2016-11-04)  

 



 

 

  

  

  

 

 

 

8-11 Munpyeongseo-ro, Daedeok-gu, Daejeon, 34302, Republic of Korea 

+82-42-930-8777 (Korea: 1588-9788) 

+82-42-930-8688 

sales@bioneer.com 

www.bioneer.com 

1301 Marina Village PKWY, Suite 110, Alameda, CA 94501, USA 

+1-877-264-4300 (Toll-free) 

+1-510-865-0350 

order.usa@bioneer.com 

us.bioneer.com 

Korea Bio Park BLDG #B-702, 700 Daewangpangyo-ro, Bundang-gu, Seongnam-si 

Gyeonggi-do, 13488, Republic of Korea 

+82-31-628-0500 

+82-31-628-0555 

sales@bioneer.co.kr 

www.bioneer.co.kr 


